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2 VERICUT Installationsanleitung 
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4 VERICUT Installationsanleitung 

1. Systemvoraussetzungen 

 

Bitte beachten Sie immer unsere aktuellen Systemvoraussetzungen im Internet, diese werden 

regelmäßig aktualisiert: 

http://www.cgtech.de/vericut_support/system-requirements/  

 

Hinweis: 
 
VERICUT 8.1 setzt die Installation eines aktuellen Grafikkartentreibers voraus. 
Wenn kein aktueller Grafikkartentreiber installiert ist kann es beim Starten von VERICUT 8.1 
zu Problemen kommen. 
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5 VERICUT Installationsanleitung 

2. Installationsvoraussetzungen 

 

Für einen reibungslosen Installationsverlauf müssen folgende Vorgaben erfüllt sein: 

 Windows-Anmeldung mit lokalen Administratorrechten 

 Die Benutzerkontensteuerung (UAC) muss temporär deaktiviert werden.  

 

 

2.1 Deaktivieren der Windows-Benutzerkontensteuerung (UAC) 

 

Dies gilt nur für Windows-Versionen seit Windows Vista, Windows XP enthält diese Funktion noch 

nicht. Nach dem Installationsvorgang kann die Benutzerkontensteuerung wieder aktiviert werden. 

Vorgehensweise: 

 Windows-Startmenü 

 „uac“ in Suchfeld eingeben 

 Schiebregler ganz nach unten ziehen 

 Mit [OK] bestätigen 
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6 VERICUT Installationsanleitung 

3. Installation von VERICUT 

 

Das Installationsprogramm enthält außer VERICUT auch den Reviewer, während des 

Installationsvorgangs kann gewählt werden welche Programme installiert werden sollen. 

 
Seit der VERICUT Version 7.4 hat der Lizenzserver eine eigene Installationsroutine. 
 
 

Hinweis: 
 
Bitte beachten Sie, dass die Installationsvoraussetzungen aus Punkt 2 erfüllt sind. 
 
 

 

Das VERICUT Installationsarchiv kann unter den folgenden Adressen heruntergeladen werden: 

Aktuelle Version:  

www.cgtech.com/products/latest-release/VERICUT-download  

Vorherige Versionen:  

www.cgtech.com/products/latest-release/VERICUT-download/previous-VERICUT-release  

 

 

Zum Download werden eine Kunden-ID, der passende Access-Code und ein Passwort für das Zip-

Archiv benötigt. Diese Daten erhalten alle Kunden bei einem Release automatisch per Email. Falls 

diese Daten nicht mehr vorliegen können sie über den CGTech Support erneut zugesandt werden. 

 

Hinweis: 
 
Mehrere VERICUT-Versionen können problemlos parallel betrieben werden. 
 
 

 

http://www.cgtech.de/
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7 VERICUT Installationsanleitung 

3.1 Start der Installation 

 

Nach dem Download kann das Archiv extrahiert werden, die Installation startet durch die Datei 

„install.exe“ 

 

 

 Die Installation wird vorbereitet und das 
Installationsprogramm startet. 
 
Sprache wählen 
 

 
Einführung----------------------------------------------------------------------------------------------------------------------- 

1 Der Installationsassistent begleitet Sie 
durch das Setup 
 
 

 
Lizenzvereinbarung------------------------------------------------------------------------------------------------------------ 

2 Lizenzvereinbarungen Lesen und 
Akzeptieren 
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8 VERICUT Installationsanleitung 

Installationsordner auswählen---------------------------------------------------------------------------------------------- 

3 Installationsordner wählen. 
 
Wenn nicht anders gewünscht kann der 
vorgegebene Pfad beibehalten werden. 
 
 

 
Art der Installation   ----------------------------------------------------------------------------------------------------------- 

4 Installationsmodus wählen 
Für ein Standart-Setup wird Vollständig 
empfohlen. 
 
Der Lizenzserver hat seit der VERICUT 
Version 7.4 eine eigene 
Installationsroutine. 
 
 

 
Lizenz Server Name -------------------------------------------------------------------------------------------------------- 

5 Vorhandenen Lizenzserver wählen oder 
einen Neuen installieren. 
 
Vorhandenen Lizenzserver aus dem Netzwerk verwenden: 
IP-Adresse oder Klarnamenpfad des Lizenzservers 
 
Vorhandenen Lizenzserver auf diesem Computer 
verwenden: 
„localhost“ für lokal installierte Lizenzen. 
 
Lizenzserver auf diesem Computer installieren: 
Führt die Lizenzserver-Installation nach der VERICUt-
Installation aus. 

 

 

Verknüpfungen ----------------------------------------------------------------------------------------------------------------- 

6 Einstellen an welchen Orten 
Verknüpfungen zu VERICUT erstellt 
werden dürfen. 
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9 VERICUT Installationsanleitung 

Verknüpfungen ------------------------------------------------------------------------------------------------------------ 

7 Hier kann gewählt werden welche 
Verknüpfungen angelegt werden sollen. 
 
Der VERICUT-REVIEWER ist Lizenzfrei 
installierbar! 
 
 

 
Standardeinheiten ------------------------------------------------------------------------------------------------------------- 

8 Mit welcher Standard-Einheit soll VERICUT 
gestartet werden? 
 
 
 
 

 
Schnittstellen-------------------------------------------------------------------------------------------------------------------- 

9 Falls eine der unterstützten CAM-
Schnittstellen verwendet werden soll, 
kann diese hier gewählt werden 
 

 
Übersicht vor Installation ---------------------------------------------------------------------------------------------------- 

10 Die Installationsübersicht fasst alle 
getroffenen Einstellungen zusammen. 
 
Bitte Kontrollieren. 
 
 

 
  

http://www.cgtech.de/
mailto:support.de@cgtech.com


 

 

 

CGTech www.cgtech.de support.de@cgtech.com Seite 10 

 

10 VERICUT Installationsanleitung 

Installiert …----------------------------------------------------------------------------------------------------------------------- 

11 Der Installationsvorgang startet, VERICUT 
wird installiert. 
 

 
Fertig------------------------------------------------------------------------------------------------------------------------------- 

12 Auswahl selektieren um weitere 
Informationen angezeigt zu bekommen 
oder um die Lizenzserver-Software zu 
installieren. 
 
 
 

 
Fertig------------------------------------------------------------------------------------------------------------------------------- 

13 Herzlichen Glückwunsch, die Installation 
wurde erfolgreich Beendet. 
 
Bitte Punkt 3.2 der Installationsanleitung 
beachten! 
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11 VERICUT Installationsanleitung 

3.2 Microsoft Runtime-Dateien 

 

Je nach Windowsversion, Softwareinstallationen und Updatestand müssen die aktuellen Microsoft 

Visual C++ Runtime-Dateien installiert werden.  

CGTech liefert aktuelle Versionen dieser Dateien mit dem Installationsarchiv mit. 

 

Diese liegen im VERICUT-Installationsverzeichnis im Unterordner redist, zusätzliche Runtime-Dateien 

für die Model-Interfaces liegen im Unterordner windows(64)\spatial\redist. 

Alternativ sind alle Runtime-Dateien auch gesammelt unter folgender Adresse zu erhalten: 

http://download.cgtech.com/redistributables.zip  

 

Ordner öffnen und daraus je nach ihrem Systemtyp folgende Runtime-Dateien installieren: 

 Windows 32Bit: Alle Dateien mit *x86* im Dateinamen. 

 Windows 64Bit: Alle Dateien mit *x64* im Dateinamen. 

 

Hinweis: 
 
Falls statt einer Installationsroutine ein Reparaturmodus startet, kann die Installation abgebrochen 
werden, da die benötigten Dateien bereits installiert sind. 
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12 VERICUT Installationsanleitung 

4. Installation der Lizenz 

 

Je nach bestellter Lizenz kann der Lizenzserver auf einem Arbeitsplatzrechner oder auf einem 

Netzwerkserver betrieben werden, die Installation unterscheidet sich dadurch ein wenig. 

 

Hinweis: 
 
Für VERICUT ab Version 8.1 wird mindestens die Version 9.1 der Lizenzserver-Software benötigt! Die 
Version ist unter anderem über WlmAdmin einsehbar. 
 
 

 

4.1 Ermitteln der Host-ID 

 

Zum Beantragen einer VERICUT-Lizenz ist die Host-ID des Lizenzservers nötig, diese kann über das 

Programm hostinfo.bat im Installationsarchiv des Lizenzservers angezeigt werden.  

 Seit 7.3 abwärts finden Sie dieses Programm auch im Windows-Startmenü unter Start > Alle 

Programme > CGTech Lizenzserver Lizenz Server   Anzeige der HOST ID. 

 Alternativ kann das Programm auch hier heruntergeladen werden:  

box.maschinen-simulation.de/cgtech_hostinfo.zip   

 

 

Hinweis: 
 
Bitte beachten, dass VERICUT Lizenzen seit Version 7.3 nur dann auf virtuellen Servern lauffähig sind, 
wenn sie auch für virtuelle Server generiert wurden. 
Weitere Informationen unter: http://www.cgtech.de/vm/ 
 

http://www.cgtech.de/
mailto:support.de@cgtech.com
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13 VERICUT Installationsanleitung 

4.2 Installation der Lizenzserver-Software 

Hinweis: 
 
Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfüllt sind. 
 
 

Der Installer der VERICUT Lizenzserver-Software ist auch im VERICUT Installationsarchiv vorhanden 

und kann über „license_server_install.exe“ gestartet werden. 

 

Die Installation wird vorbereitet und das Installationsprogramm startet. 

 

Einführung----------------------------------------------------------------------------------------------------------------------- 

1 Der Installationsassistent begleitet Sie 
durch das Setup. 
 
 

 
Lizenzvereinbarung------------------------------------------------------------------------------------------------------------ 

2 Lizenzvereinbarungen Lesen und 
Akzeptieren. 
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14 VERICUT Installationsanleitung 

Installationsordner auswählen---------------------------------------------------------------------------------------------- 

3 Installationsordner wählen. 
 
Wenn nicht anders gewünscht kann der 
vorgegebene Pfad beibehalten werden. 
 
 

 
Verknüpfungen------------------------------------------------------------------------------------------------------------------ 

4 Einstellen an welchen Orten 
Verknüpfungen zum VERICUT Lizenzserver 
erstellt werden dürfen. 
 

 
Übersicht vor Installation----------------------------------------------------------------------------------------------------- 

5 Die Installationsübersicht fasst alle 
getroffenen Einstellungen zusammen. 
 
Bitte Kontrollieren. 
 
 

 
Installiert …----------------------------------------------------------------------------------------------------------------------- 

6 Der Installationsvorgang startet, der 
VERICUT Lizenzserver wird installiert. 
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15 VERICUT Installationsanleitung 

Fertig------------------------------------------------------------------------------------------------------------------------------- 

7 Herzlichen Glückwunsch, die Installation 
wurde erfolgreich Beendet. 
 
Verlassen Sie den Dialog über die 
Schaltfläche [Fertig]. 
 
 

 
 

Im nächsten Schritt muss nun noch die Lizenz selbst installiert werden. Weitere Informationen dazu 

unter Punkt 4.3. 

 

 

 

4.2.1 Update der Lizenzserver-Software (z.B.: für VERICUT 8.1) 

 

Hinweis: 
 
Für VERICUT ab Version 8.1 wird mindestens die Version 9.1 der Lizenzserver-Software benötigt! Die 
Version ist unter anderem über WlmAdmin einsehbar. 
 
 

Im ersten Schritt muss die alte Version der Lizenzserver-Software deaktiviert werden, dies 

funktioniert über den Startmenü-Eintrag: „Entfernen des Lizenz Servers“. 

Das anschließende Update der Lizenzserver-Software wird generell wie eine komplette 

Neuinstallation ausgeführt. Die Installation funktioniert wie unter Punkt 4.2 beschrieben. 

 

4.3 Installation einer Lizenz auf dem Lizenzserver  

 

Auch nach einem Update der Lizenzserver-Software muss dem Punkt 4.3.1 gefolgt werden. 
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16 VERICUT Installationsanleitung 

4.3.1 Erstinstallation 

Hinweis: 
 
Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfüllt sind. 
 
 

Dieser Vorgang muss nur auf dem Computer, auf dem der Lizenzserver laufen soll, ausgeführt 

werden! 

Konfiguration von Lizenz und Setupserver aus 
dem Windows-Startmenü unter Alle 
Programme > CGTech License Server > License 
Server Only > Configure License & Setup Server 
 
zweimal mit Enter bestätigen 
 

 
-------------------------------------------------------------------------------------------------------------------------------------- 
Bei der Installation des Lizenzservers wird die 
Systemvariable „LSERVOPTS“ gesetzt. 
 
Der Wert dieser Variablen lautet  
-s"C:\ProgramData\CGTech\license\cgtech.lf" 
 
Wenn der Lizenzmanager hier eine Fehlermeldung 
anzeigt muss die Systemvariable “LSERVOPTS” von 
Ihnen angepasst werden. 

 
-------------------------------------------------------------------------------------------------------------------------------------- 
Die erhaltene Lizenz in diesem Fenster ablegen. 
  
Folgende Vorgehensweisen sind möglich: 

 Kompletten Inhalt der Lizenzmail per 
Drag&Drop in dieses Fenster ziehen. 

 Kompletten Inhalt der Lizenzmail per 
Copy&Paste hier einfügen. 

 Speichern der Lizenzmail als Textdatei 
und per Drag&Drop in dieses Fenster 
ziehen. 

 
-------------------------------------------------------------------------------------------------------------------------------------- 
In der letzten Zeile sollte nun zu sehen sein: 
„Lizenzdatei C:\ProgramData\CGTech\license\cgtech.lf erfolgreich 
erstellt“. 
Fenster schließen und mit Enter in der 
Kommandozeile bestätigen. 
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17 VERICUT Installationsanleitung 

Es wird Empfohlen ihre VERICUT-Installation jetzt zu testen! 

 Falls der Lizenzserver auf dem Arbeitsplatzrechner installiert ist sollten sich VERICUT nun 

direkt starten lassen. 

 

 Falls der Lizenzserver nicht auf dem Arbeitsplatzrechner installiert ist, müssen die VERICUT-

Arbeitsplätze eventuell noch wie in Punkt 4.4.2 beschrieben konfiguriert werden. 

 

Der Lizenzserver nun richtig Konfiguriert. 

 

Hinweis: 
 
Falls Fehlermeldungen auftreten, bitte die Installationsvoraussetzungen aus Punkt 2 und den FAQ-
Bereich unter Punkt 7 beachten. 
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18 VERICUT Installationsanleitung 

4.3.2 Lizenz-Update 

 

Hinweis: 
 
Für VERICUT ab Version 8.1 wird die aktuelle Version des Lizenzservers benötigt! 
Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfüllt sind. 
 
 

Dieser Vorgang muss auf dem Computer, auf dem der Lizenzserver laufen soll ausgeführt werden. 

 

Starten des Programms Save License File From 
Email aus dem Windows-Startmenü unter Alle 
Programme > CGTech License Server > License 
Server Only 
 
Die erhaltene Lizenz in diesem Fenster ablegen. 
  
Folgende Vorgehensweisen sind möglich: 

 Kompletten Inhalt der Lizenzmail per 
Drag&Drop in dieses Fenster ziehen. 

 Kompletten Inhalt der Lizenzmail per 
Copy&Paste hier einfügen. 

 Speichern der Lizenzmail als Textdatei 
und per Drag&Drop in dieses Fenster 
ziehen 

 
Im Textfeld des Fensters sollten nun einige 
Lizenzinformationen zu sehen sein. 
Bitte  prüfen ob der Code unter Ethernet der 
Host ID des Lizenzservers entspricht. 
 
In der letzten Zeile sollte nun zu sehen sein: 
„Lizenzdatei 
C:\ProgramData\CGTech\license\cgtech.lf 
erfolgreich erstellt“. 
 
 
 
Fenster mit Close schließen und mit Enter in der 
Kommandozeile bestätigen. 
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Es wird Empfohlen ihre VERICUT-Installation jetzt zu testen! 

Um die Lizenz dauerhaft zu aktivieren, muss das Programm Update Licenses on Running Server aus 

dem Windows-Startmenü unter Alle Programme > CGTech License Server > License Server Only 

ausgeführt werden. 

Die Lizenz ist ab sofort dauerhaft aktiviert. 

 
 

Der Lizenzserver nun richtig Konfiguriert. 

 

Hinweis: 
 
Falls Fehlermeldungen auftreten, bitte die Installationsvoraussetzungen aus Punkt 2 und den FAQ-
Bereich unter Punkt 7 beachten. 
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4.4 Lizenzübertragung 

 

4.4.1 Lizenzübertragung anfordern 

 

Durch ändern des Lizenzservers wird auch eine neue Lizenz benötigt, diese kann auf unserer 

Homepage unter folgender Adresse beantragt werden: 

www.cgtech.de/VERICUT_support/request-license 

 

4.4.2 VERICUT für neuen Server einstellen 

 

Im Falle eines Lizenzserverwechsels muss VERICUT mitgeteilt werden wo es nach einer VERICUT-

Lizenz suchen soll. 

Dabei hilft seit VERICUT 7.3 der folgende Startmenüeintrag: Alle Programme > CGTech VERICUT 8.1> 

Lizenz Administration > Lizenz Server Namen angeben. 

Alternativ findet sich das Programm auch im VERICUT Installationsverzeichnis unter VERICUT 

8.1\windows64\commands\change_cgtenv.bat 

 

 

Ändern der Zeile: 
 

set LSHOST=localhost 

 
von localhost auf die Adresse des Lizenzservers, 
z.B.: 
 

set LSHOST=licenseserver01 

 
 

 

 
 

 

Falls bereits eine Windows Umgebungsvariable mit der Benennung LSHOST angelegt wurde, muss 

diese auch geändert werden. 

 

Die Konfiguration ist nun abgeschlossen.  

http://www.cgtech.de/
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5. Models Interface 

 

Je nach bestellter Lizenz können über das VERICUT Models Interface verschiedene Import- und 

Export-Schnittstellen verwendet werden.  

 

Hinweis: 
 
Dies kann bei der Installation direkt mit angewählt werden. 
 
 

Falls das Models Interface bei noch nicht installiert ist, wird die Datei unter folgendem Downloadlink 

benötigt: 

www.cgtech.com/products/latest-release/VERICUT-download/model-interfaces  

 

 VERICUT Beenden. 

 Datei herunterunterladen und entpacken. 

 Programm install.exe ausführen und den Anweisungen folgen. 

 Bei „Installationsordner auswählen“ muss der Pfad zur aktuellen VERICUT-Installation 

angeben. 

(Beispielpfad.: C:\Programme\CGTech\Vericut 8.1) 

 Im Ordner Redistributables werden aktuelle C++Runtime-Dateien mitgeliefert. Falls diese 

nicht bereits bei einer vorherigen Installation installiert wurden, sollte dies nun nachgeholt 

werden. 

Siehe dazu Punkt 3.2. 

o Für gewöhnlich muss folgende Datei installiert werden: 

InstallDSSoftwareVC9Prerequisites_x86_64.msi aus dem Ordner: 

Installationsverzeichnis\windows(64)\spatial\redist 

 

Die Installation der Model Interfaces ist nun abgeschlossen. 
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6. Installation der *CAM-to-VERICUT-Schnittstellen 

 

Um den CAM-Export möglichst einfach zu machen, liefert CGTech mit VERICUT bereits einige 

Schnittstellen zu CAM-Software mit.  

Diese Schnittstellen müssen nach der VERICUT-Installation noch in ihrem jeweiligen CAM-Programm 

aktiviert werden. 

 

6.1.1 CATIAV5-to-VERICUT 

Die Anleitung bezieht sich auf CATIA V5 und VERICUT 8.03 

Die CATIAV5-Schnittstelle (CATV 8 Build 5) setzt  mindestens eine CATIA V5 (R16 oder höher) 

Installation voraus. 

 

 CATIA und VERICUT beenden 

 Kopieren der Dateien I_CATV.bmp aus dem VERICUT Installationsverzeichnis  

(Beispielpfad: C:\Programme\CGTech\Vericut 8.0.3\windows64\catv5)   

aus den Unterordnern: Normal und Small 

in das CATIA Installationsverzeichnis unter  intel_a\resources\graphic\icons 

(Beispielpfad: C:\Programme\Dassault Systemes\B23\win_b64\resources\graphic\icons)  

In die Ordner Normal und Small 

 CATIA V5 starten 

 In den „Advanced  Machining“-Bereich wechseln 

 Im Menü: Tools > Makro > Makros wählen 

o Auf Makrobibliotheken klicken 

 Vorhandene Bibliothek hinzufügen… 

 Wählen des Eintrags im Unterordner windows(64)\catv5 des 

VERICUT-Installationsverzeichnisses. 

(Beispielpfad: C:\Programme\CGTech\Vericut 

8.0.3\windows64\catv5) 

 Fenster Makrobibliotheken schließen 

o Fenster Makros schließen. 
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23 VERICUT Installationsanleitung 

 

 

 

 Im Menü: Tools > Anpassen wählen 

 Auf den Reiter Befehle wechseln 

 Links die Kategorie Makros wählen 

 Rechts unter Befehle: CATV.CATScript wählen 

 Darunter auf Eigenschaften anzeigen… klicken 

 Durch Klick auf den Button „…“ öffnet sich der Icon-Browser, hier muss das 

VERICUT-Symbol gesucht und gewählt werden. 

 Die Benennung des Icons auf „VERICUT“ ändern 

 Den Eintrag CATV.CATScript mit der Maus per Drag&Drop an die gewünschte 

Stelle in der CATIA-Toolbar ziehen 

 Das Fenster Anpassen schließen 

 

 

 

 

 

Die Installation der Schnittstelle ist nun abgeschlossen. 
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6.1.2 CATIAV6-to-VERICUT 

- vericut 8.0.3 & CATIA V6 x13 

1. Testen Sie zunächst, ob Sie die CATV6-Schnittstelle manuell starten können. 
Wechseln Sie dazu in Ihrem VERICUT-Installationsverzeichnis (z.B. C:\CGTech\VERICUT_8.0.3) 

in den Ordner „…windows64\CATV6“ und starten die Datei „catv6.exe“ mit einem 

Doppelklick. 

 

 

 

2. Kopieren Sie aus Ihrem VERICUT-Installationsverzeichnis die Icons (*.bmp)  
“Normal” (z.B. C:\CGTech\VERICUT_8.0.3\windows64\catv5\Normal) und  

“Small” (z.B. C:\CGTech\VERICUT_8.0.3\windows64\catv5\Small)  

in folgende Ordner Ihrer CATIA V6 Installation: 

C:\Program Files\Dassault Systemes\B214\win_b64\resources\graphic\icons\normal 

C:\Program Files\Dassault Systemes\B214\win_b64\resources\graphic\icons\small 

 

3. Starten Sie CATIA V6 und wählen Sie aus dem Menü den Eintrag  Tools  Macros  
Macros (oder drücken Sie auf der Tastatur ALT & F8) und wählen Sie im sich öffnenden 
Fenster den Eintrag  Macro Libraries aus. 
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4. Wählen Sie im folgenden Fenster bei  Library type den Typen  PLM Directories aus und 
klicken anschließend auf  Create New Library 

 

 

5. Tragen Sie bei  Name den Namen  VERICUT_CATV6_Script ein und verlassen die Maske 
mit  OK. 
 

 

 

6. Verlassen Sie das Fenster  Macro libraries über  Close. 
 

 

 

7. Im Fenster  Macros wählen Sie bei  Current Macro das gerade erstellte 
VERICUT-Script aus und klicken dann auf  Create.  
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8. Wählen Sie nun bei  Macro language  CATScript aus und geben Sie als  Macro name  
CATV6.CATScript an. Verlassen Sie die Maske über  OK. 
 

 

 

9. Wählen Sie nun  Edit. 
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10. Fügen Sie folgende Zeile zwsischen  Sub CATMain() und  End Sub ein: 
CATIA.SystemService.ExecuteBackgroundProcessus 

"C:\cgtech74x\windows64\commands\catv6.bat" 

 

 Der Pfad zu Ihrer VERICUT-Installation muss ggf. angepasst werden! 
 

 

 

11. Wählen Sie  File > Save aus und verlassen Sie dann die Maske über  File Exit. 
12. Verlassen Sie das  Macros Fenster über  Close. 
13. Wählen Sie im CATIA Menü  Tools  Customize  Commands aus und wählen Sie die 

Kategorie  Macros an. Dann wählen Sie das  CATV6.CATScript aus und klicken auf  
Show Properties. 
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14. Klicken Sie auf    und wählen das Symbol   VERICUT aus der Liste aus. 
 

  

 

15. Verlassen Sie über  Close den Icon-Browser. 
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16. Wählen Sie im  Customize Fenster Toolbars aus.  
Klicken Sie dann auf eine Toolbar Ihrer Wahl, z.B. Standart, und klicken dann 

auf  Add commands. 

 

 

 

 

17. Wählen Sie  CATV6.CATScript aus und klicken auf  OK.  
 

 

 

18. Verlassen Sie das  Customize Fenster über  Close. 
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6.2 Edgecam-to-VERICUT 

Die Anleitung bezieht sich auf EDGECAM 2016R2 und VERICUT 8.03 

 

Hinweis: 
 
Diese Schnittstelle kann mit einem Installer installiert werden. 
 
 

 

Manuelle Installation  

 

Kopieren Sie folgende Dateien aus der Grafik unten aus C:\Program Files\CGTech\VERICUT 

8.0.x\windows64\edgecam\2016R2 

nach C:\Program Files\Vero Software\Edgecam 2016 R\(jeweiliege Ordner wie unten aufgeführt)  

 

 

 

Kopieren Sie weitere Dateien aus C:\Program Files\CGTech\VERICUT 

8.0.x\windows64\edgecam\2016R2\German 

nach C:\Program Files\Vero Software\Edgecam 2016 R\(jeweiliege Ordner wie unten aufgeführt)  
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Das VERICUT Menü im Edgecam Menü und in der Edgecam Toolbar integrieren: 

 

Starten Sie Edgecam 

 

 Machen Sie auf dem Setup Reiter einen Rechtsklick und wählen Customize the Ribbon 

  
o Wählen Sie unter Choose commands from  All Commands 

o Klicken Sie auf New Tab und erstellen ein neuen Ordner unter dem Verzeichnis NC 
Code Namens VERICUT 

o Selektieren Sie die Datei VERICUT und VERICUT Voreinstellung mittels der Taste STRG 
o Über die Schaltfläche ADD kopieren Sie beide Dateien in das neue Verzeichnis 

 

 Die VERICUT-Schnittstelle wird in Edgecam ab sofort in der Toolbar und im Menü angezeigt.  
 
 
 

 

Die Installation der Schnittstelle ist nun abgeschlossen.   
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6.3 Mastercam-to-VERICUT 

Die Anleitung bezieht sich auf MasterCam 2017 und VERICUT 8.03 

 

Hinweis: 
 
Diese Schnittstelle kann mit einem Installer installiert werden. 
 

 

 Beenden Sie Mastercam und VERICUT. 

 Kopieren Sie folgende Dateien aus ihrem VERICUT Installationsverzeichnis  

(Beispielpfad: C:\Programme\CGTech\Vericut 8.0.3\windows64\mcamv\2017)  

in ihr Mastercam Installationsverzeichnis  

(Beispielpfad: C: \Programme\mcam2017\chooks). 

o SetStock.dll nach chooks\SetStock.dll 

o VERICUT.dll nach chooks\VERICUT.dll 

o VERICUT.ft nach chooks\VERICUT.ft 

o Mcres.local nach Program Files\mcam2017 

o VERICUTSupport.dll nach chooks\VERICUTSupport.dll 

 Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen: 

Variable Beispielwert (Erklärung) 

CGTECH_INSTALL C:\Programme\CGTech\Vericut 8.0.3 

CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64 

LSHOST Licenseserver01  
(Hostname ihres Lizenzservers) 

 

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und 

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen. 
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Die VERICUT Schnittstelle in die Mastercam Toolbar integrieren 

 

 Machen Sie auf dem Home Reiter einen Rechtsklick und wählen Customize The Ribbon 
 

o Wählen Sie unter Choose commands from  All Commands 

o Klicken Sie auf New Group und erstellen Sie ein neuen Ordner unter dem Verzeichnis 
Maschine Namens VERICUT 

o Selektieren Sie das VERICUT Icon 
o Über die Schaltfläche ADD kopieren Sie die Dateien in das neue Verzeichnis 

 

 Die VERICUT-Schnittstelle wird in Mastercam ab sofort in der Toolbar unter dem Reiter 
Maschine angezeigt.  
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6.4 NX-to-VERICUT 

Die Anleitung bezieht sich auf NX10 und VERICUT 8.03 

 

 Beenden Sie NX und VERICUT. 

 Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen: 

 

Variable Beispielwert (Erklärung) 

CGTECH_INSTALL C:\Programme\CGTech\Vericut 8.0.3 

CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64 

LSHOST Licenseserver01  
(Hostname ihres Lizenzservers) 

UGS_LICENSE_BUNDLE NCFOUND;NXPTNR100 

UGII_VENDOR_DIR %CGTECH_PRODUCTS%\nx\NX10\german (Pfad zu ihrer 
NX-Schnittstelle) 

 

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und 

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen. 

DATEIEN KOPIEREN  

Kopieren Sie aus  C:Programme\CGTech\Vericut_8.0.3\windows64\nx\NX10\german  

 

Und fügen sie hier wieder ein  

C:\Program Files\Siemens\NX 10.0\UGALLIANCE\vendor 

 

Die Installation der Schnittstelle ist nun abgeschlossen. 

 

Alternativ können Sie NX auch über eine Batch-Datei im VERICUT Installationsverzeichnis starten. 

(Beispielpfad: C:\Programme\CGTech\Vericut 8.0.3\windows64\commands\nx10.bat)  
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6.4 Gibbs-to-VERICUT 

 

Die Anleitung bezieht sich auf Gibbs 11.3 und VERICUT 8.03 

 

 Beenden Sie Gibbs und VERICUT. 

 Kopieren Sie folgende Datei aus ihrem VERICUT Installationsverzeichnis  

(Beispielpfad: C:\Programme\CGTech\Vericut 8.0.3\windows64\GibbsV)  

in ihr Gibbs Installationsverzeichnis  

(Beispielpfad: C: \Programme\3D Systems\GibbsCAM\ 11.3.18.0-de-AT\Plugins). 

o GibbsV.dll 

 Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen: 

 

Variable Beispielwert (Erklärung) 

CGTECH_INSTALL C:\Programme\CGTech\Vericut 8.0.3 

CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64 

LSHOST Licenseserver01  
(Hostname ihres Lizenzservers) 

GIBBSV_LANGUAGE %CGTECH_PRODUCTS%\GibbsV\GibbsvGerman.local 

 

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und 

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen. 

 

 Die VERICUT-Schnittstelle wird in Gibbs ab sofort im Menü Plugins angezeigt. 

 

Die Installation der Schnittstelle ist nun abgeschlossen. 
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6.6 CREO-to-VERICUT 

 

Die Anleitung bezieht sich auf CREO 3.0 und VERICUT 8.03 

 

 Beenden Sie CREO und VERICUT. 

Kopieren Sie die Datei protk.dat aus ihrem VERICUT Installationsverzeichnis  

(Beispielpfad: C:\Programme\CGTech\Vericut 8.0.3 \windows64\proev\Creo30)  

in ihr Pro/E Installationsverzeichnis unter \text 

(Beispielpfad: C:\Program Files\PTC\Creo 3.0\M080\Common Files\text). 

 Ändern Sie mit einem Texteditor den Dateiinhalt so ab, dass er passend zu ihrer VERICUT-

Installation folgendem ähnelt: 

 

name cgtproev 
startup dll 
exec_file C:\Programme\CGTech\Vericut 8.0.3\windows64\proev\Creo30\cgtproev.dll 
text_dir C:\Programme\CGTech\Vericut 8.0.3\windows64\proev\Creo30\text 
revision Wildfire 
end 

 

 

 Die Datei proev.txt enthält die Beschreibungen, die später im Creo Popdownmenü angezeigt 

wird.  

Die Zeilen „VERICUT…“ und „Invoke the VERICUT Interface“ können beliebig geändert 

werden. 

 

 

 

 

 

 

 Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen: 
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Variable Beispielwert (Erklärung) 

CGTECH_INSTALL C:\Programme\CGTech\Vericut 8.0.3 

CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64 

LSHOST Licenseserver01  
(Hostname ihres Lizenzservers) 

PROEV_LANGUAGE %CGTECH_PRODUCTS%\proev\Creo30\ProevGerman.local 

 

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und 

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen. 

 

 Die VERICUT-Schnittstelle wird in Creo ab sofort unter Toolkit / VERICUT … angezeigt. 

 

Die Installation der Schnittstelle ist nun abgeschlossen. 
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6.7 hyperMILL-to-VERICUT 

 

Diese Installationsanleitung bezieht sich auf hyperMILL 2014.2. Andere Versionen könnten 

abweichen. 

 Beenden Sie hyperMILL und VERICUT. 

 Wählen Sie aus dem Startmenü: 

[Open Mind] > [hyperMILL] > [2014.2] > [Anwendungseinstellungen]  

 Wählen Sie [Neu] und füllen Sie das sich öffnende Fenster wie folgt aus: 

 

 Die VERICUT.bat Datei bestimmt mit welcher VERICUT-Version die Schnittstelle gestartet 

wird. Verlassen Sie das Fenster mit [OK] und beenden Sie die Anwendungseinstellungen. 

 In hyperMILL muss nun noch in den Postprozessor Einstellungen der jeweiligen Maschine der 

Eintrag [Externe Simulation] > [Vericut] hinzugefügt werden.  

 

 Die Schnittstelle ist nun installiert. 
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7. FAQ, häufige Fragen & Fehlermeldungen 

7.1 Downloadarchiv kann nicht entpackt werden /Kein gültiges Archiv 

Vermutlich gab es ein Problem beim Download, bitte wiederholen. 

Eventuell unterstützt das verwendete Packprogramm keine Passwortgeschützten Archive.  

Bitte mit einer aktuellen Version eines gängigen Packprogramms, wie WinZip, WinRAR oder 7Zip 

testen. 

 

 

 

 

7.2 Es kann keine VERICUT Lizenz gefunden werden 

 

Meldung: 
 
Es kann keine VERICUT Lizenz gefunden werden. Der Lizenzserver ist eventuell nicht gestartet auf 
{Lizenzserver} oder VERICUT kann keinen Kontakt aufnehmen mit {Lizenzserver}. Bitte schauen Sie in 
die Installationshinweise für weitere Hilfe. 
 
 

Lösungsvorschlag 

 

 Mit dem Programm Lizenz Administrator (WlmAdmin) aus dem Windows-Startmenü unter 

Alle Programme > CGTech Lizenzserver > Lizenz Administration prüfen ob der erwartete 

Lizenzserver sichtbar ist. 

 change_cgtenv.bat starten 

Die Datei ist unter folgendem Pfade zu finden: VERICUT\ 

C:\Programme\VERICUT 8.1\windows64\commands 

Prüfen ob neben „LSHOST=“ der richtige Lizenzserver angegeben ist. 

 Prüfen ob Windows den Lizenzserver erreichen kann. Dazu in die Windows 

Kommandoanzeige wechseln und „ping xyz“ eingeben. 

xyz muss mit der unter LSHOST eingegebenen Adresse ersetzt werden.   
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 In den Windows Umgebungsvariablen prüfen ob LSHOST eingetragen ist. Falls nicht, diesen 

Eintrag manuell hinzufügen. Als Wert muss der Hostname des Lizenzservers angegeben 

werden. 

 

Falls dies nicht zum Erfolg führt sollte Punkt 4.3.1 noch einmal ausgeführt werden. Bitte darauf 

achten, dass die Lizenz dauerhaft aktiviert wird. 
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7.3 Lizenzserver wurde gefunden, aber CGTech Lizenzinformationen sind nicht vorhanden 

Meldung: 
 
Lizenzserver wurde gefunden, aber CGTech Lizenzinformationen sind nicht vorhanden. Eventuell 
falsche Version des Lizenzservers oder der Lizenzdatei.  
Bitte schauen Sie in die Installationshinweise für weitere Hilfe. 
 
 

Lösungsvorschlag 

  

 Prüfen ob der Pfad zur Lizenzdatei richtig angegeben ist (auf dem Lizenzserver), dieser kann 

über die Windows Umgebungsvariablen LSERVOPTS angegeben werden.  

Der Wert der Variablen sieht ab VERICUT 7.4 immer gleich aus: 

-s "C:\ProgramData\CGTech\license\cgtech.lf" 

 Prüfen ob die Datei vorhanden ist. 

 Falls der Lizenzserver nicht auf den Arbeitsplatzcomputer läuft, prüfen ob auf beiden 

Rechnern (Server&Client) im Programm Lizenz Administrator (WlmAdmin)  bei Version im 

Kasten Server information identische Werte stehen. 

Die Version auf dem Server darf nicht älter sein. 

 Mit WlmAdmin prüfen ob die Lizenzen VERIFICATION und VERICUT.WIN angezeigt werden. 

 

Falls dies nicht zum Erfolg führt sollte Punkt 4.3.1 noch einmal ausgeführt werden. Bitte darauf 

achten, dass die Lizenz dauerhaft aktiviert wird. 

 

Lösungsvorschlag 2 

  

Prüfen ob der Lizenzserver von ihrer Firewall blockiert wird. 

Der Lizenzserver benötigt den Port 5093 auf Client- und Serverrechner. 
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7.4 Lizenzserver wurde gefunden, aber es sind keine VERICUT Module vorhanden. 

Meldung: 
 
Lizenzserver wurde gefunden, aber es sind keine VERICUT Module vorhanden. 
 
 

Lösungsvorschlag 

  

 Diese Fehlermeldung tritt häufig auf wenn versucht wird VERICUT Standard mit einer 

VERICUT LIMITED/SP-Lizenz auszuführen. 

Zum Betreiben von VERICUT wird eine Standard-Lizenz benötigt. 

 Falls im Startmenü kein VERICUT Limited/SP - Eintrag vorhanden ist, wurde dies bei der 

Installation nicht ausgewählt.  

Ein neuer Eintrag kann durch kopieren der Datei „Verknüpfung zu Limited VERICUT 64 8.1“ 

aus dem Installationsverzeichnis unter windows64\commands erzeugt werden. 
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7.5 The given license code is invalid. 

Meldung: 
 
The given license code is invalid. Hence, it could not be added to the “..” license server. 
 

 
 
 

 

Lösungsvorschlag 1 

Für VERICUT ab Version 7.3 wird mindestens die Version 8.5.3.35 der Lizenzserver-Software benötigt! 

Die Version ist unter anderem über WlmAdmin einsehbar. 

Bitte Punkt 4.2.1 folgen 

 

Lösungsvorschlag 2 

Die Lizenz-Codes dürfen keine Leerzeichen oder Zeilenumbrüche beinhalten. Diese werden teils 

automatisch beim Speichern aus Outlook eingefügt.  

Als Alternative dazu kann der Email-Text per Copy & Paste in das Lizenz-Fenster eingefügt werden. 

 

 Beispiele für Lizenz-Codes 
Korrekt (ohne Zeilenumbrüche) 
 
# CGTECH_LICENSE 7.3 31-Dec-2013  

 

*E IcwaL3gSoKgt8JZsJTr0E…gekürzt…88no0Bgt8JZTZXL3gSoXh33e 

 
Fehlerhaft: (mit Zeilenumbrüchen) 
 
# CGTECH_LICENSE 7.3 31-Dec-2013  

 

*E IcwaKsJgt8JZsJ 

r0E…gekürzt…88no0 

Tr0E3FrpvFGjMfmdv 
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7.6 Cannot talk to license server  

Meldung: 
 
Cannot talk to licence server on host “CG6326”. Server not running? 
 

 
 

Lösungsvorschlag 1 

 
 
[Windows-Startmenü] > 
[Programme/Dateien Durchsuchen] 
> Suche nach „cmd“ 

 

 
 

 
 
[RMT] auf „cmd“ > 
[Als Administrator ausführen] 
 

 

 
 

 
Geben Sie in der Kommandozeile 
folgende Befehle ein: 
 
cd Installationspfad License Server 
 
Beispiel: 
 
cd C:\CGTech\LicenseServer  
 

 

 

 
In der nun dazu gekommenen 
nächsten Zeile tragen Sie bitte 
folgendes ein: 
 
setup_license_service.bat 
 
Bestätigen Sie zwei Mal mit einer 
beliebigen Taste. 

 

 

 
Folgen Sie nun Schritt 4.3.1 der 
Installations-Anleitung.  
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8. Weitere Hilfe 

 

Kontaktdaten 

Weitere Hilfe zu VERICUT erhalten Sie jederzeit über unseren Support: 

 

CGTech GmbH 

Neusser Landstr. 384 

50769 Köln 

Hotline: 0221-97996-0 

Fax: 0221-97996-28 

support.de@cgtech.com 

 

Weblinks 

Deutschsprachige Website: www.cgtech.de & www.maschinen-simulation.de  

Englischsprachige Website: www.cgtech.com  

Aktuelle Version dieser Anleitung: www.box.maschinen-simulation.de/install  

 

Hilfe-Forum 

www.cgtech.com/forum  
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